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1 ¡Bienvenido al mundo de GUITAR RIG!

 

GUITAR RIG KONTROL es la solución ideal para guitarristas y bajistas. El pedal RIG KON-
TROL se acopla perfectamente con el programa GUITAR RIG y proporciona una calidad de so-
nido superior gracias a su interfaz de audio integrada. Diseñado y optimizado para su uso con
GUITAR RIG, cumple con todos los estándares de la industria, ofrece un total soporte MIDI y
puede usarse perfectamente con la mayoría de los programas profesionales de audio.

El RIG KONTROL se conecta al ordenador mediante una conexión USB 2.0 de alta velocidad,
a través de la cual recibe también su alimentación eléctrica. Cuenta con dos entradas aptas
tanta instrumentos como para señales de nivel de línea. Una línea de salida de dos canales
permite la conexión del aparato al sistema de altavoces y un enchufe estéreo permite la cone-
xión de los auriculares con manejo de volumen independiente.

Como controlador, RIG KONTROL ofrece nueve interruptores y un pedal permitiéndo un control
casi total de todas las funciones de GUITAR RIG. Además, presenta conexiones MIDI y dos en-
tradas análogas para su conexión a controladores externos.

En los capítulos siguientes describiremos las características del RIG KONTROL y su mejor mo-
do de empleo. Por favor, lea esta manual cuidadosamente para poder familiarizarse a fondo
con el producto.

¡Bienvenido al mundo de GUITAR RIG!
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2 Antes de empezar: Observaciones importantes

 

Antes que nada, lea primero este capítulo cuidadosamente antes de emplear GUITAR RIG.

2.1 Números de serie y chapa identificadora
 

GUITAR RIG KONTROL posee dos números de serie. En la parte inferior del producto, encon-
trará el número de serie del RIG KONTROL y la chapa identificadora con el nombre del modelo
y otras especificaciones técnicas. El número de serie necesario para la activación de GUITAR
RIG está situado en funda del DVD del producto.

2.2 Usar la unidad de manera segura
 

Lea estas instrucciones atentamente para evitar daños a su salud o al producto.

2.2.1 Advertencia
 

Para evitar posibles daños a los oídos, observe las siguientes advertencias:

▪ Este producto combinado con un amplificador, auriculares o altavoces puede generar so-
nidos de volumen muy alto perjudiciales para el oído.

▪ Para su protección, baje el volumen de todos los dispositivos antes de ponerse a usar el
RIG KONTROL. Al tocar la música, suba el volumen gradualmente hasta alcanzar el nivel
deseado.

▪ No lo utilice durante tiempos prolongados a volúmenes elevados. Si experimenta proble-
mas auditivos o zumbidos en los oídos, consulte inmediatamente al médico.

2.2.2 Precauciones
 

Para evitar que se produzcan daños en el RIG KONTROL o en los dispositivos conectados du-
rante su uso o mantenimiento, observe las siguientes recomendaciones:

Antes de empezar: Observaciones importantes
Números de serie y chapa identificadora
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▪ No abra el dispositivo ni intente desarmarlo o modificar su interior. El dispositivo tiene
componentes que no pueden ser reparados por el usuario. Si el aparato no funcionara co-
rrectamente, suspenda inmediatamente su uso y hágalo revisar por personal calificado.

▪ No exponga el aparato a la lluvia y no lo utilice cerca del agua o en condiciones de hume-
dad.

▪ Evite la penetración de cualquier objeto o líquido en la unidad.

▪ Nunca use o guarde la unidad en lugares sujetos a temperaturas extremas (p. ej., bajo la
luz directa del sol en un automóvil o cerca de la calefacción) o a altos niveles de vibra-
ción.

▪ No coloque el RIG KONTROL en una posición inestable en la que pueda caer al piso acci-
dentalmente. Antes de mover la unidad, desenchufe los cables conectados.

▪ Antes de encender o apagar algún componente, ponga a mínimo el volumen del mismo.

▪ No emplee excesiva fuerza al usar las perillas o los conectores.

▪ Para la limpieza del RIG KONTROL use un paño suave y seco. No emplee solventes, líqui-
dos limpiadores o paños con químicos limpiadores.

2.2.3 Deposición del producto
 

Si por alguna causa el producto se estropeara sin posibilidad de arreglo o si llegara al término
de su vida útil, cumpla con las regulaciones de su país relativas a la deposición de residuos
electrónicos.

2.3 Descargo de responsabilidad
 

Native Instruments GmbH no puede responsabilizarse por daño al aparato o pérdida de datos
causados por uso indebido o por modificaciones realizadas al RIG KONTROL.

La información contenida en este manual es la correcta al momento de su impresión o apari-
ción digital. Sin embargo, Native Instruments se reserva el derecho de realizar modificaciones
a las especificaciones existentes, en cualquier momento, y sin previo aviso ni obligación de ac-
tualizar las unidades existentes.

Antes de empezar: Observaciones importantes
Usar la unidad de manera segura
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3 El RIG KONTROL

 

Este capítulo le brindará un panorama general de la mecánica del RIG KONTROL.

3.1 Panel superior
 

El panel superior del RIG KONTROL.

(1) Los interruptores de pie pueden asignarse en el programa para realizar tareas tales como el
recorrido de presetes o el apagado/encendido de componentes individuales. Cada interruptor
cuenta con un LED que indica si el mismo se encuentra o no activado. La fila superior de inte-
rruptores está identificada con el nombre de las funciones más frecuentes de GUITAR RIG y
ejecuta las correspondientes funciones preconfiguradas.

El RIG KONTROL
Panel superior
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(2) El pedal de expresión puede usarse para controlar cualquier parámetro continuo del progra-
ma, tal como el volumen o el wah-wah. Bajo la punta del pedal hay un interruptor libremente
asignable.

(3) Muestra el números del preset activado.

(4) Este LED es un medidor que muestra el volumen de entrada de la señal de audio. Cuando
está rojo, indica la presencia de distorsión. Si lo hace, baje entonces la ganancia de entrada.

(5) Este LED es un medidor que muestra el volumen de salida de la señal de audio. Cuando
está rojo, indica la presencia de distorsión. Si lo hace, baje entonces el volumen de salida.

(6) Este LED indica que el RIG KONTROL está recibiendo señales MIDI provenientes de un
secuenciador u otro tipo de controlador.

(7) Este LED muestra si el interruptor bajo el pedal se encuentra o no activado.

3.2 Panel posterior
 

El panel posterior del RIG KONTROL.

(1) El interruptor Inst/Line establece la sensibilidad de entrada para las entradas 1 y 2. Cuan-
do no está presionado, las entradas aceptan señales provenientes de instrumentos como guita-
rras o bajos; cuando está presionado, aceptan señales de nivel línea. El tipo de entrada selec-
cionado se indica en la parte de arriba de la unidad.

(2) Esta perilla controla la ganancia de la entrada 1.

El RIG KONTROL
Panel posterior
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(3) El enchufe de Input 1 (conector de ¼”, TRS balanceado) acepta la entrada de señales de
nivel de línea o de instrumento, dependiendo de como esté puesto el interruptor Line/Inst. Co-
necte aquí su guitarra, bajo o teclado, o el canal izquierdo de un dispositivo estéreo.

(4) El enchufe de Input 2 (conector de ¼”, TRS balanceado) acepta la entrada de señales de
nivel de línea o de instrumento, dependiendo de como esté puesto el interruptor Line/Inst. Co-
necte aquí una segunda guitarra, bajo o teclado, o el canal derecho de un dispositivo estéreo.

(5) Esta perilla controla la ganancia de la entrada 2.

(6) Esta conexiones transmiten la salida de la interfaz de audio. Utilice ambas para obtener
sonido estéreo.

(7) La amplificación de la salida puede ser máxima o de -14 dB.

(8) Control de volumen independiente para la salida de auriculares.

(9) Enchufe para la conexión de auriculares estéreo.

(10) Enchufe para la conexión de pedales de expresión externos, interruptores de pie, pedales
de volumen o cajas interruptoras.

(11) El RIG KONTROL cuenta también con una interfaz MIDI de una entrada y una salida. El
RIG KONTROL no necesita MIDI para enviar mensajes de controlador a GUITAR RIG pero pue-
de enviar señales MIDI a otras aplicaciones.

(12) El puerto USB conecta la unidad con el ordenador. El ordenador debe contar con puertos
USB 2.0 para poder trabajar con el aparato. La unidad también se alimenta de la energía eléc-
trica transmitida a través del puerto USB. Conecte la unidad directamente en un puerto USB
2.0 del ordenador y evite el empleo de concentradores (hubs) sin fuente de alimentación pro-
pia. Como seguridad, debería enganchar siempre el cable USB en el gancho correspondiente.

El RIG KONTROL
Panel posterior
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4 Instalación en Windows

 

Este capítulo describe la instalación básica del RIG KONTROL en Windows 7, haciendo espe-
cial hincapé en la instalación de la interfaz de audio. Para activar el pedal en GUITAR RIG y
emplear su capacidad MIDI, consulte el capítulo ↑7, Empleo del RIG KONTROL como un con-
trolador de este manual.

Para más información sobre el programa GUITAR RIG, consulte el manual de dicha aplicación.
El mismo se encuentra en el DVD del producto o en el menú de GUITAR RIG bajo la opción
Help > Open Manual > Spanish.

4.1 Instalación del programa 
 

Asegúrese de haber iniciado la sesión con privilegios de administrador. No conecte todavía el
RIG KONTROL.

1. Revise el contenido del DVD para ubicar el archivo de instalación. Si está empleando una
versión descargada de GUITAR RIG, deberá primero extraer el archivo de instalación.

2. Haga doble clic en el archivo de instalación de GUITAR RIG ("Guitar Rig 5 [número de
versión] Setup PC.exe") para iniciar el proceso de instalación.

3. Siga las instrucciones en pantalla que lo guiarán a través del proceso de instalación. Se
recomienda instalar el programa en su ubicación por defecto.

4. Se le pedirá especificar la carpeta destinada al plugin VST. Si no sabe lo que es un plugin
VST o si está seguro de que solamente utilizará GUITAR RIG en su modalidad indepen-
diente (stand-alone), utilice la configuración estándar. Si, en cambio, desea emplear GUI-
TAR RIG como plugin dentro de un programa anfitrión, deberá seleccionar la carpeta em-
pleada para alojar los plugines de su programa anfitrión.

5. Se le preguntará si desea instalar los controladores de dispositivo para las interfaces de
audio de GUITAR RIG. Marque la casilla junto a Install the Rig Kontrol 3 Driver y haga
clic en Next.

6. Es posible que al finalizar se le pida reiniciar el ordenador.
Las siguientes aplicaciones han sido instaladas en el ordenador:

▪ El programa GUITAR RIG (stand-alone).

Instalación en Windows
Instalación del programa
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▪ Los plugines GUITAR RIG: utilice GUITAR RIG como plugin en la estación de audio digi-
tal (EAD) de su preferencia. En ordenadores con Windows, GUITAR RIG funciona con los
formatos de plugin VST y RTAS.

▪ Service Center: esta aplicación se ocupa de la activación del producto y de gestionar las
actualizaciones. Consulte la guía de instalación (Setup Guide) para más información.

▪ Los controladores de dispositivo del RIG KONTROL.

Si solamente desea instalar los controladores del aparato, en el DVD de instalación hallará
por separado el correspondiente archivo de instalación del controlador. También podrá des-
cargar la última versión del mismo en la sección de asistencia (Support) del sitio de Internet
de Native Instruments.

4.2 Instalación del aparato
 

Utilice el cable USB suministrado con el producto para conectar el RIG KONTROL directamen-
te a un puerto USB 2.0 del ordenador.

Conexión del controlador al ordenador.

El RIG KONTROL se alimenta a través de la conexión USB. Su operación sólo puede garanti-
zarse si se lo emplea como dispositivo único de un puerto USB 2.0 o con un hub USB 2.0 con
fuente de alimentación propia.

Instalación en Windows
Instalación del aparato
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► Tras la correcta instalación del controlador de dispositivo, el RIG KONTROL será reconocido
automáticamente. Si esto no llegara a ocurrir, inicie nuevamente la instalación del programa
de la manera ya descrita.

A continuación, distintos módulos de controlador serán asignados al RIG KONTROL, cada uno
de ellos ocasionando la aparición de una ventana emergente notificando la instalación del con-
trolador.

En un ordenador con Windows, el controlador está asociado a un puerto USB en particular.
Si enchufa el cable USB en un puerto distinto al empleado para la instalación, el procedi-
miento de asignación de controladores empezará de nuevo.

Si en algún momento, el ordenador parece no reconocer el RIG KONTROL, desconecte el ca-
ble USB, espere unos segundos y vuelva a conectarlo. Si el problema continua, reinicie el
ordenador teniendo la interfaz conectada.

4.3 Configuración
 

Este apartado explica el empleo de la interfaz de audio RIG KONTROL en Windows y con el
programa GUITAR RIG. Se da por sentado que GUITAR RIG ya fue activado a través de la apli-
cación Service Center. De no ser así, consulte por favor la guía de instalación para más deta-
lles sobre el registro del producto.

4.3.1 Configuración de GUITAR RIG
 

Ahora vamos a configurar GUITAR RIG para su uso con la interfaz de audio RIG KONTROL.

► Primero, inicie el programa.

Cuando el programa arranque por primera vez, el cuadro de configuración de audio y MIDI
(Audio and MIDI Settings) se abrirá automáticamente para permitir llevar a cabo los ajustes
necesarios (para acceder más tarde a este cuadro, seleccione en el menú del programa la op-
ción File > Audio and MIDI Settings:

Instalación en Windows
Configuración
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La ventana The Audio and MIDI Settings.

1. En la ficha Audio, seleccione la opción ASIO en el menú desplegable de controladores
(Driver).

2. En el menú Device, seleccione RIG KONTROL 3.
3. Seleccione una frecuencia de muestreo (Sample Rate) que sea compatible con su progra-

ma de música y con la capacidad de cálculo del ordenador. Por defecto, la frecuencia de
muestreo está puesta en 44100 Hz (calidad de CD). Valores más altos proporcionan una
calidad de sonido mejor pero causan, a su vez, un mayor consumo de CPU. Por lo gene-
ral, 44100 Hz es la configuración más frecuentemente empleada.

Si RIG KONTROL 3 no aparece en la lista de dispositivos, entonces algo ha salido mal. Vuel-
va a efectuar la instalación de la manera ya descrita en ↑4.1, Instalación del programa .

Configuración avanzada

Para llevar a cabo configuraciones avanzadas mediante el panel de control del controlador,
consulte el apartado ↑5.4, Conexiones de audio y niveles.

Instalación en Windows
Configuración
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4.3.2 Empleo del RIG KONTROL como la interfaz de audio predeterminada
 

Si desea usar el RIG KONTROL para reproducir todas las aplicaciones de audio de su ordena-
dor (y no sólo los programas de música), deberá configurarlo para que sea la interfaz de audio
predeterminada del sistema. En Windows 7, haga lo siguiente:

1. Abra Inicio > Panel de control > Hardware y sonido > Sonido.
2. Seleccione la ficha de Reproducción.
3. En la lista de dispositivos, seleccione RIG KONTROL 3 Output y luego haga clic en Prede-

terminar.
4. Selección la ficha de Grabar.
5. En la lista de dispositivos, seleccione RIG KONTROL 3 Input y luego haga clic en Prede-

terminar.

Instalación en Windows
Configuración
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6. Haga clic en Aceptar para finalizar.

4.4 Conexiones de audio y niveles de volumen
 

En los apartados siguientes aprenderá la manera de conectar el RIG KONTROL a su guitarra y
sistema de altavoces, y a establecer los niveles de amplificación correctos tanto en el aparato
como en el programa. Antes de continuar, inicie por favor la aplicación GUITAR RIG.

4.4.1 Conectar el instrumento y ajustar el volumen de entrada
 

1. Baje el volumen de su sistema de monitorización para evitar lesiones auditivas.

Instalación en Windows
Conexiones de audio y niveles de volumen
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2. Asegúrese de que el selector de entradas esté puesto en la opción de amplificación de en-
trada del instrumento (el botón LINE/INST, en la parte posterior del RIG KONTROL, tiene
que estar presionado), a menos que esté empleando un preamplificador para reforzar la
señal hasta el nivel de línea.

3. Enchufe el cable de su guitarra o bajo en una de las entradas del RIG KONTROL.
4. Baje el volumen del canal de entrada que no esté usando.
Tenga en cuenta que los instrumentos que generan señales estéreo, como por ejemplo los sin-
tetizadores de teclado, deberán ser conectados a ambos canales de entrada para obtener soni-
do estereofónico.

Conexión de una guitarra o bajo al controlador.

Para obtener la mejor calidad de sonido posible, deberá suministrarle a la interfaz una señal
que sea suficientemente potente; por lo tanto, ajuste cuidadosamente el volumen de entrada
del RIG KONTROL. El medidor del volumen de entrada le indicará el volumen de la señal en-
trante.

Estado del medidor Significado

Los LED están apagados La señal no está presente.

Los LED verdes están en-
cendidos

Se está registrando el in-
greso de la señal.

Los LED verdes y rojos es-
tán encendidos

El volumen de la señal en-
trante es muy alto.

Instalación en Windows
Conexiones de audio y niveles de volumen
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Antes de ajustar la sensibilidad de entrada, baje la perilla de volumen de su guitarra. Toque
algunos acordes al volumen al que acostumbra tocar y eche un vistazo al medidor del volumen
de entrada:

1. Mientras está tocando, suba la perilla del volumen de entrada junto al enchufe de entrada
utilizado hasta que el medidor apenas alcance la zona roja.

2. Ahora, baje despacio la perilla hasta que los LED dejen de emitir luz roja, aun al tocar
acordes muy fuertes.

Ahora la sensibilidad de entrada está puesta en un nivel óptimo y el RIG KONTROL puede pro-
porcionar un rango dinámico muy alto sin caer en distorsión.

4.4.2 Conectar un segundo instrumento
 

Es posible conectar un instrumento en cada canal siempre que los mismos suministren el mis-
mo tipo de señal (línea o instrumento). Enchufe el cable de un segundo instrumento en la otra
entrada y ajuste el nivel de volumen de la manera descrita en el apartado anterior.

Si solamente emplea un canal, la perilla de ganancia (Gain) del otro canal debe estar puesta
en cero.

Para instrumentos que generan una señal estéreo, es necesario utilizar también el segundo ca-
nal para lograr así un sonido estereofónico.

4.4.3 El volumen de entrada de GUITAR RIG
 

Vamos a dar por sentado que la guitarra ya está conectada al RIG KONTROL y que el volumen
de entrada fue correctamente ajustado (véase ↑4.4.1, Conectar el instrumento y ajustar el vo-
lumen de entrada). Ahora debemos asegurarnos de que la señal de entrada sea procesada por
el programa con un nivel de volumen adecuado.

Eche un vistazo a la cabecera de GUITAR RIG: está compuesta por un módulo de entrada con
selectores de canal (L/R), un supresor de ruido (Gate) sencillo, un módulo de salida con un
limitador y, finalmente, la información del consumo de CPU.

La cabecera del programa GUITAR RIG.
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Tenga en cuenta que el medidor de entrada mostrará la amplitud al tocar el instrumento. Tam-
bién hallará un deslizante de volumen que controla el volumen de entrada del programa. Ajus-
te este control hasta conseguir el nivel más alto posible sin producir distorsión. Esto lo podrá
comprobar con el medidor de volumen, que se acercará hasta la zona roja sin llegar realmente
a alcanzarla.

Si solamente una guitarra se hallara conectada, GUITAR RIG recibirá una señal mono. Usted
puede también configurar el módulo de entrada para que direccione la señal de su guitarra a
través de ambos canales. Por defecto, GUITAR RIG está configurado para procesar ambos ca-
nales de entrada (L y R están activados), por lo que uno de los canales permanecerá, entonces,
en silencio. Para cambiar esto, desactive el canal que no esté usando: cliquee el botón corres-
pondiente (L o R) a la izquierda del medidor de volumen para desactivar dicho canal y que so-
lamente quede activo el canal de entrada en uso. Con esto, dirigirá la señal monoaural hacia
ambos canales.

4.4.4 Conectar la salida
 

El RIG KONTROL proporciona dos salidas mono para la conexión del sistema de amplificación,
sea éste una mesa de mezclas, un par de altavoces activos o un sistema estereofónico hogare-
ño. Tenga en cuenta que para lograr sonido estéreo, deberá conectar ambas salidas. Un salida
estéreo separada (TRS) permite la conexión de los auriculares.
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Conexión de altavoces y auriculares al controlador.

1. Conecte las salidas del aparato con la entrada de su sistema de amplificación, habiendo
bajado previamente el volumen.

2. Si está usando auriculares, conéctelos en el enchufe de salida y tenga la precaución de
bajar el volumen antes de ponérselos.

3. Vaya al buscador de presetes y seleccione un preset con un clic.
4. Empiece a tocar y suba cuidadosamente el volumen del amplificador o el volumen del

RIG KONTROL, para sus auriculares, hasta alcanzar el nivel deseado.
Ahora todo está listo, ¡ya puede empezar a tocar!
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5 Instalación en Mac OS X

 

Este capítulo describe la instalación básica del RIG KONTROL en Mac OS X, haciendo espe-
cial hincapé en la instalación de la interfaz de audio. Para activar el pedal en GUITAR RIG y
emplear su capacidad MIDI, consulte el capítulo ↑7, Empleo del RIG KONTROL como un con-
trolador de este manual.

Para más información sobre el programa GUITAR RIG, consulte el manual de dicha aplicación.
El mismo se encuentra en el DVD del producto o en el menú de GUITAR RIG bajo la opción
Help > Open Manual > Spanish.

5.1 Instalación del programa 
 

Asegúrese de haber iniciado la sesión con privilegios de administrador. No conecte todavía el
RIG KONTROL.

1. Revise el contenido del DVD y ubique el archivo “GUITAR RIG Installer”. Si está em-
pleando una versión descargada de GUITAR RIG, deberá primero extraer el archivo de ins-
talación.

2. Haga doble clic sobre el archivo de instalación para iniciar el proceso de instalación.
3. Siga las instrucciones en pantalla que lo guiarán a través del proceso de instalación.
4. Se le preguntará si desea instalar los controladores de dispositivo para las interfaces de

audio de GUITAR RIG. Seleccione RIG KONTROL 3 driver (el mismo puede aparecer ya
preseleccionado) y haga clic en Continue.

5. Completada la instalación, reinicie el ordenador.
Las siguientes aplicaciones han sido instaladas en el ordenador:

▪ El programa GUITAR RIG (stand-alone).

▪ Los plugines GUITAR RIG: utilice GUITAR RIG como plugin en la estación de audio digi-
tal (EAD) de su preferencia.

▪ Service Center: esta aplicación se ocupa de la activación del producto y de gestionar las
actualizaciones. Consulte la guía de instalación (Setup Guide) para más información.

▪ Los controladores de dispositivo del RIG KONTROL.
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Si es propietario por primera vez de un producto Native Instruments, deberá registrarse si-
guiendo las instrucciones ofrecidas en pantalla. Para más información sobre como crear una
cuenta de usuario NI y sobre la activación de GUITAR RIG, consulte la guía de inicio rápido
o el manual del Service Center, ubicados en la carpeta de instalación del Service Center.

Si solamente desea instalar los controladores del aparato, en el DVD de instalación hallará
por separado el correspondiente archivo de instalación del controlador. También podrá des-
cargar la última versión del mismo en la sección de asistencia (Support) del sitio de Internet
de Native Instruments.

5.2 Instalación del aparato
 

Utilice el cable USB suministrado con el producto para conectar el RIG KONTROL directamen-
te a un puerto USB 2.0 del ordenador.

Conexión del controlador al ordenador.

El RIG KONTROL se alimenta a través de la conexión USB. Su operación sólo puede garanti-
zarse si se lo emplea como dispositivo único de un puerto USB 2.0 o con un hub USB 2.0 con
fuente de alimentación propia.

► Tras la correcta instalación del controlador de dispositivos, el RIG KONTROL será reconoci-
do automáticamente. Si esto no llegara a ocurrir, inicie nuevamente la instalación del progra-
ma de la manera ya descrita.
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A continuación, distintos módulos de controlador serán asignados al RIG KONTROL, cada uno
de ellos ocasionando la aparición de una ventana emergente notificando la instalación del con-
trolador.

Si en algún momento, el ordenador parece no reconocer el RIG KONTROL, desconecte el ca-
ble USB, espere unos segundos y vuelva a conectarlo. Si el problema continua, reinicie el
ordenador teniendo la interfaz conectada.

5.3 Configuración
 

Este apartado explica el empleo de la interfaz de audio RIG KONTROL en Mac OS X y con el
programa GUITAR RIG. Se da por sentado que GUITAR RIG ya fue activado a través de la apli-
cación Service Center. De no ser así, consulte por favor la guía de instalación para más deta-
lles sobre el registro del producto.

5.3.1 Configuración de GUITAR RIG
 

Ahora vamos a configurar GUITAR RIG para su uso con la interfaz de audio RIG KONTROL.
Primero, inicie el programa.
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1. Cuando el programa arranque por primera vez, el cuadro de configuración de audio y MIDI
(Audio and MIDI Settings) aparecerá automáticamente para que pueda llevar a cabo las
configuraciones correspondientes. Para abrir esta ventana en un momento posterior, en la
barra de menús del programa seleccione Guitar Rig > Preferences.

2. Abra la ficha Audio y, en Driver, seleccione CoreAudio como interfaz del controlador.
3. En el menú de dispositivos (Device), seleccione RigKontrol3.

Si RIG KONTROL no aparece en la lista, entonces algo ha salido mal. Vuelva a efectuar la
instalación de la manera ya descrita en ↑5.1, Instalación del programa .

La interfaz de audio permite la configuración de los siguientes parámetros:

▪ Sample Rate: seleccione una frecuencia de muestreo que sea compatible con su progra-
ma de música y con la capacidad de cálculo del ordenador. Por defecto, la frecuencia de
muestreo está puesta en 44100 Hz (calidad de CD). Frecuencias más altas pueden mejo-
rar la calidad del sonido pero exigirán, a su vez, una capacidad de procesamiento mayor.

Instalación en Mac OS X
Configuración

 

RIG KONTROL 3 - Guía de usuario - 26



La frecuencia de muestreo define la cantidad de muestras ejecutadas/grabadas por cada se-
gundo de sonido. Una frecuencia alta genera una calidad de sonido mejor, sin embargo,
44100 Hz (valor empleado para la grabación de CD) es la configuración habitual y suficiente
para la mayoría de los usos. Si el destino final de su trabajo es un CD, use este valor o un
múltiplo del mismo (88200 Hz). Un valor de 48000 Hz se usa en grabadores DAT y para la
grabación de DVD (películas). 96000 Hz y valores superiores son empleados habitualmente
para grabaciones en DVD, HD DVD y Blue-ray Disc. Debería tener en cuenta que una fre-
cuencia de muestreo alta ocasiona una mayor carga al CPU.

▪ Latency: el deslizante de latencia permite establecer el tamaño del búfer de la interfaz de
audio (medido en samples). Esto presenta dos efectos: cuanto mayor sea el tamaño del
búfer, menor será la probabilidad de experimentar problemas en el audio cuando éste sea
procesado en tiempo real. Por otra parte, el tamaño del búfer afecta directamente la la-
tencia general del sistema. Si incrementa el tamaño del búfer, el tiempo transcurrido en-
tre la ejecución de una nota y el momento cuando ésta suena será mayor.

Recomendamos empezar primero con el tamaño de búfer predeterminado y continuar con los
restantes pasos de la instalación. Cuando haya terminado, en algún momento posterior debería
cargar un preset sin usar y revisar nuevamente la ficha de configuración de audio y MIDI para
determinar la mejor latencia para su sistema. Esto se logra moviendo paulatinamente el desli-
zante de latencia (Latency) hacia la izquierda mientras se está ejecutando alguna música. Si
empieza a percibir ruidos o fallas, arrastre lentamente el deslizante hacia la derecha hasta que
los mismos cesen por completo.

5.3.2 Empleo del RIG KONTROL como la interfaz de audio predeterminada
 

Si desea usar el RIG KONTROL para la reproducción de audio general del ordenador (y no sólo
de los programas de música), deberá configurarlo para que sea la interfaz de audio predetermi-
nada del sistema. En Mac OS X haga lo siguiente:

1. Desde el menú de Apple, seleccione Preferencias del sistema:
2. En el panel que se abre, seleccione Sonido.
3. En la ficha Efectos de sonido, seleccione RigKontrol3 en el menú de Ejecutar efectos de

sonido.
4. Haga clic en la ficha Salida y seleccione la opción RigKontrol3 de la lista de Choose a

device for sound output.
5. Haga clic en la ficha Entrada y seleccione la opción RigKontrol3 de la lista de Choose a

device for sound input.
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5.4 Conexiones de audio y niveles
 

En los apartados siguientes aprenderá la manera de conectar el RIG KONTROL a su guitarra y
sistema de altavoces, y a establecer los niveles de amplificación correctos tanto en el aparato
como en el programa. Antes de continuar, inicie por favor la aplicación GUITAR RIG.

5.4.1 Conectar el instrumento y ajustar el volumen de entrada
 

1. Baje el volumen de su sistema de monitorización para evitar lesiones auditivas.
2. Asegúrese de que el selector de entradas esté puesto en la opción de amplificación de en-

trada del instrumento (el botón LINE/INST, en la parte posterior del RIG KONTROL, tiene
que estar presionado), a menos que esté empleando un preamplificador para reforzar la
señal hasta el nivel de línea.

3. Enchufe el cable de su guitarra o bajo en una de las entradas del RIG KONTROL.
4. Baje el volumen del canal de entrada que no está usando.
Tenga en cuenta que los instrumentos que generan señales estéreo, como por ejemplo los sin-
tetizadores de teclado, deberán ser conectados a ambos canales de entrada para obtener soni-
do estereofónico.

Conexión de una guitarra o bajo al controlador.
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Para obtener la mejor calidad de sonido posible, deberá suministrarle a la interfaz una señal
que sea suficientemente potente; por lo tanto, ajuste cuidadosamente el volumen de entrada
del RIG KONTROL. El medidor del volumen de entrada le indicará el volumen de la señal en-
trante.

Estado del medidor Significado

Los LED están apagados La señal no está presente.

Los LED verdes están en-
cendidos

Se está registrando el in-
greso de la señal.

Los LED verdes y rojos es-
tán encendidos

El volumen de la señal en-
trante es muy alto.

Antes de ajustar la sensibilidad de entrada, baje la perilla de volumen de su guitarra. Toque
algunos acordes al volumen al que acostumbra tocar y eche un vistazo a los LED:

1. Mientras está tocando, suba la perilla del volumen de entrada junto al enchufe de entrada
utilizado hasta que el medidor apenas alcance la zona roja.

2. Ahora, baje despacio la perilla hasta que los LED dejen de emitir luz roja, aun al tocar
acordes muy fuertes.

Ahora la sensibilidad de entrada está puesta en un nivel óptimo y el RIG KONTROL puede pro-
porcionar un rango dinámico muy alto sin caer en distorsión.

5.4.2 Conectar un segundo instrumento
 

Es posible conectar un instrumento en cada canal siempre que los mismos suministren el mis-
mo tipo de señal (línea o instrumento). Enchufe el cable de un segundo instrumento en la otra
entrada y ajuste el nivel de volumen de la manera descrita en el apartado anterior.

Si solamente emplea un canal, la perilla de ganancia (Gain) del otro canal debe estar puesta
en cero.

Para instrumentos que generan una señal estéreo, es necesario utilizar también el segundo ca-
nal para lograr así un sonido estereofónico.
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5.4.3 El volumen de entrada de GUITAR RIG
 

Vamos a dar por sentado que la guitarra ya está conectada al RIG KONTROL y que el volumen
de entrada fue correctamente ajustado (véase ↑5.4.1, Conectar el instrumento y ajustar el vo-
lumen de entrada). Ahora debemos asegurarnos de que la señal de entrada sea procesada por
el programa con un nivel de volumen adecuado.

Eche un vistazo a la cabecera de GUITAR RIG: está compuesta por un módulo de entrada con
selectores de canal (L/R), un supresor de ruido (Gate) sencillo, un módulo de salida con un
limitador y, finalmente, la información del consumo de CPU.

La cabecera del programa GUITAR RIG.

Tenga en cuenta que el medidor de entrada mostrará la amplitud al tocar el instrumento. Tam-
bién hallará un deslizante de volumen que controla el nivel de entrada del software. Ajuste es-
te control hasta conseguir el nivel más alto posible sin producir distorsión. Esto lo podrá com-
probar con el medidor de volumen, que se acercará hasta la zona roja sin llegar realmente a
alcanzarla.

Si solamente una guitarra se hallara conectada, GUITAR RIG recibirá una señal mono. Usted
puede también configurar el módulo de entrada para que direccione la señal de su guitarra a
través de ambos canales. Por defecto, GUITAR RIG está configurado para procesar ambos ca-
nales de entrada (L y R están activados), por lo que uno de los canales permanecerá, entonces,
en silencio. Para cambiar esto, desactive el canal que no esté usando: cliquee el botón corres-
pondiente (L o R), a la izquierda del medidor de volumen, para desactivar dicho canal y que
solamente quede activo el canal de entrada en uso. Con esto, dirigirá la señal monoaural hacia
ambos canales.

5.4.4 Conectar la salida
 

El RIG KONTROL proporciona dos salidas mono para la conexión del sistema de amplificación,
sea éste una mesa de mezclas, un par de altavoces activos o un sistema estereofónico hogare-
ño. Tenga en cuenta que para lograr sonido estéreo, deberá conectar ambas salidas. Un salida
estéreo separada (TRS) permite la conexión de los auriculares.
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Conexión de altavoces y auriculares al controlador.

1. Conecte las salidas del aparato con la entrada de su sistema de amplificación, habiendo
bajado previamente el volumen.

2. Si está usando auriculares, conéctelos en el enchufe de salida y tenga la precaución de
bajar el volumen antes de ponérselos.

3. Vaya al buscador de presetes y seleccione un preset con un clic.
4. Empiece a tocar y suba cuidadosamente el volumen del amplificador o el volumen del

RIG KONTROL, para sus auriculares, hasta alcanzar el nivel deseado.
Ahora todo está listo, ¡ya puede empezar a tocar!

Instalación en Mac OS X
Conexiones de audio y niveles

 

RIG KONTROL 3 - Guía de usuario - 31



6 Configuración avanzada

 

6.1 Configuración avanzada en Windows
 

El panel de control del controlador (Control Panel) se abre desde el cuadro de configuración de
audio y MIDI (Audio and MIDI Settings), cliqueando en la opción ASIO Config., (en el menú de
GUITAR RIG: File > Audio and MIDI Settings). El panel de control presenta, al final de la ven-
tana, un campo que muestra si el RIG KONTROL se encuentra conectado y listo para usar.

El panel de control y la ficha Audio Settings.

6.1.1 Ficha Audio Settings
 

La página Audio Settings permite configurar la latencia de audio y la frecuencia de muestreo, y
supervisa el estado del dispositivo. La página Audio Settings consta de dos secciones: Audio
Processing y Device Monitor.
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Sección Audio Processing

La sección Audio Processing permite establecer los parámetros para la conversión analógica-
digital / digital-analógica llevada a cabo por la interfaz de audio. Presenta dos menús:

▪ Sample Rate: seleccione una frecuencia de muestreo que sea compatible con su progra-
ma de música y con la capacidad de cálculo del ordenador. Una frecuencia de muestreo
alta mejora la calidad del audio pero también exige mayor esfuerzo del ordenador. Por de-
fecto, la frecuencia de muestreo está puesta en 44100 Hz (calidad de CD).

La frecuencia de muestreo define la cantidad de muestras ejecutadas/grabadas por cada se-
gundo de sonido. Una frecuencia alta genera una calidad de sonido mejor, sin embargo,
44100 Hz (valor empleado para la grabación de CD) es la configuración habitual y suficiente
para la mayoría de los usos. Si el destino final de su trabajo es un CD, use este valor o un
múltiplo del mismo (88200 Hz). Un valor de 48000 Hz se usa en grabadores DAT y para la
grabación de DVD (películas). 96000 Hz y valores superiores son empleados habitualmente
para grabaciones en DVD, HD DVD y Blue-ray Disc. Debería tener en cuenta que una fre-
cuencia de muestreo alta ocasiona una mayor carga al CPU.

Si desea emplear varios programas-cliente de manera simultánea con el dispositivo, tenga en
cuenta que los mismos también deberán compartir la misma frecuencia de muestreo.

▪ Process Buffer: reduzca el tamaño del búfer para lograr una respuesta más rápida entre el
ordenador y el programa de audio o las acciones generadas por un controlador MIDI.

Para convertir el audio en información digital y viceversa, el controlador de audio necesita
almacenar la información en el búfer para luego ser procesada por el CPU. Cuanto más gran-
de sea el búfer de audio, más tiempo le tomará a la señal llegar como audio hasta la salida.
Esto se percibe como una demora producida entre el momento en que se ejecuta una tecla
del ordenador o del controlador y el momento en el que efectivamente se escucha el sonido.
Esa demora se denomina latencia. Como regla práctica considere: un tamaño de búfer redu-
cido ocasionará una latencia más baja. Sin embargo, hay otros factores que inciden también
en la latencia (velocidad del CPU, RAM, etc.). Lo recomendable es empezar con un valor de
latencia relativamente elevado y bajarlo gradualmente, observando la respuesta del ordena-
dor, hasta dar con el equilibrio justo entre ejecutabilidad y desempeño del sistema. Si expe-
rimenta ruidos en la salida del audio, probablemente el valor de latencia seleccionado está
demasiado bajo y el ordenador no puede trabajar bien porque se encuentra sobreexigido.
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▪ USB Buffer: use este menú en caso de no conseguir una latencia satisfactoria con el me-
nú de Process Buffer. Reduzca el tamaño del búfer para lograr un almacenamiento más
reducido, lo cual debería reducir aún más la latencia perceptible. Si experimenta inte-
rrupciones en el audio, debería aumentar un poco el tamaño hasta conseguir un sonido
libre de fallas y caídas.

Sección Device Monitor

La sección Device Monitor muestra la información relacionada con el estado de procesamiento
de la interfaz de audio y con la latencia de salida del sistema. Presenta dos visualizadores.

▪ Processing State: este visualizador monitoriza el estado del dispositivo. Los estados posi-
bles son tres:

◦ Idle: la interfaz está conectada pero ningún cliente suministra datos.

◦ Streaming: el controlador está operando y procesando los datos de audio.

◦ Panic: el controlador dejó de transmitir. Demasiados errores de E/S USB han ocurrido
en la comunicación de la interfaz.

▪ Output Latency: muestra la latencia de salida en milisegundos.

6.1.2 Ficha Diagnostics
 

La información provista en la ficha Diagnostics resulta de interés para los usuarios avanzados;
sin embargo, en caso de surgir problemas, debería echar un vistazo sobre esta ficha.

La página de Diagnostics tiene tres secciones:

▪ Drop-Out Detection: muestra los errores de E/S USB y detecta el mal rendimiento del bú-
fer.

▪ Connection Monitor: muestra la conexión cliente-controlador de dispositivo y detecta erro-
res de datos USB.

▪ System Performance Test: ofrece la posibilidad de llevar a cabo un examen de rendimien-
to para medir los valores de latencia.

▪ Information: muestra información sobre el controlador de dispositivo y la versión del firm-
ware. También hay un enlace a la guía de solución de problemas.
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Sección de la detección de problemas (Drop-Out Detection)

La sección Drop-Out Detection presenta dos visualizadores y un botón:

▪ USB I/O Errors: cuenta los errores de entrada/salida USB. Una cifra elevada de USB I/O
Errors indicaría que el sistema está sobrecargado.

▪ Buffer Underruns: ocurre cuando el ordenador no es capaz de procesar en tiempo al búfer
de audio. Las razones de este subrendimiento son variadas, puede ser que haya demasia-
das tareas ejecutándose en segundo plano o que el consumo de CPU sea demasiado ele-
vado en un programa de música que emplea el dispositivo como controlador de audio.

▪ Reset: haga clic en este botón para restablecer la cuenta de errores.

Sección Connection Monitor

La sección Connection Monitor presenta dos visualizadores y un botón:

▪ Number of Clients: muestra el número de clientes conectados a la interfaz. Muchas apli-
caciones ASIO se cuentan separadamente, WDM y WASAPI incrementan el número en
una unidad, sin tener en cuenta la cantidad de aplicaciones WDM/WASAPI que estén eje-
cutando audio.

▪ USB Data Errors: cuenta los errores USB. Cables de mala calidad o muy prolongados, lo
mismo que la irradiación, pueden ocasionar errores de datos en el bus USB.

▪ Reset: haga clic en este botón para restablecer la cuenta de errores.

Sección de la comprobación del rendimiento del sistema (System Performance Test)

▪ Current Latency: haga clic en el botón Start para ver el valor de latencia.

▪ Maximum Latency: muestra el valor más alto de latencia de la medición.

◦ Cliquear en Reset tiene el mismo efecto que cliquear en Start por primera vez. Resta-
blece el procedimiento de examinación al comienzo e inicia un nuevo test con valores
recientes.

◦ Haga clic en Stop para detener el test. El valor de latencia máxima (Maximum Latency)
no dejará de mostrarse.

Sección Information

La sección Information presenta dos visualizadores y un botón.

Configuración avanzada
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▪ Driver Version: muestra la versión del controlador de dispositivo.

▪ Firmware Version: muestra la versión del firmware.

▪ Troubleshooting Guide: haga clic en Show para abrir la guía de solución de problemas.

6.2 Configuración avanzada en Mac OS X
 

En Mac OS X, todas las configuraciones pertinentes se llevan a cabo en la ventana de configu-
ración de audio y MIDI. Consulte el apartado ↑5.3, Configuración para más detalles.

Configuración avanzada
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7 Empleo del RIG KONTROL como un controlador

 

El RIG KONTROL multiplica el desempeño de GUITAR RIG al poder usarse como controlador
de otros dispositivos. Entre otras características, ofrece conexiones MIDI y dos enchufes para
pedales e interruptores de pie externos. Las secciones siguientes describirán la manera de con-
figurar el aparato para aprovechar al máximo todas estas características. Para saber como asig-
nar las funciones de GUITAR RIG a las entradas de datos del controlador, consulte la guía de
inicio rápido y el manual de la aplicación.

Para usar el RIG KONTROL como un controlador MIDI estándar, deberá emplear el programa
Controller Editor que viene incluido con el producto. Consulte el manual de Controller Editor
para más detalles.

7.1 Activación del RIG KONTROL en GUITAR RIG
 

El RIG KONTROL se activa de manera automática dentro de GUITAR RIG cuando se conecta
el aparato. Al activarse por primera vez, aparecerá una ventana que le pedirá calibrar el pedal.
Presione, por favor, el pedal hasta arriba y luego hasta el fondo, y confirme con OK . El pedal
puede volverse a calibrar en cualquier momento: vaya hasta la página de opciones (Options) y
seleccione Preferences. Haga clic en el botón Reset junto a la opción “Rig Kontrol Pedal Cali-
bration.

GUITAR RIG presenta también una representación gráfica del RIG KONTROL, la cual aparece
al cliquear el botón para mostrar/ocultar el Rig Kontrol, ubicado encima del rack.

Si está manejando varias instancias de GUITAR RIG (p. ej., en un secuenciador), deberá defi-
nir cuál de todas ellas será la controlada por el pedal. Por defecto, el RIG KONTROL se habili-
ta para la primera instancia activada de GUITAR RIG. Al cliquear el LED de Connect de la re-
presentación virtual en otra instancia, el RIG KONTROL pasará a esa instancia: el aparato solo
puede habilitarse para una instancia a la vez.

Algunas funciones están asignadas, por defecto, a los interruptores de pie 5-8 (como aparece
señalado por los rótulos respectivos en el hardware). Con los interruptores 5 (Preset Prev) y 6
(Preset Next) podrá recorrer los presetes que aparecen visibles en el buscador. Los interrupto-
res 7 y 8 activan la afinación (Tuner) y la estimación del tempo con el pie (Tap). Por supuesto,
estos controles pueden también reasignarse a otras funciones.

Empleo del RIG KONTROL como un controlador
Activación del RIG KONTROL en GUITAR RIG

 

RIG KONTROL 3 - Guía de usuario - 37



La manera más fácil para asignar el pedal o un botón del RIG KONTROL a cualquiera de las
funciones del rack es arrastrar el pedal o el botón desde el gráfico del Virtual Kontrol hasta la
función que se desea asignar. Para una descripción detallada del funcionamiento de las asig-
naciones, consulte por favor la guía de inicio rápido y el manual de la aplicación.

7.2 Empleo de controladores MIDI con la interfaz MIDI RIG KONTROL
 

Mientras que el RIG KONTROL se comunica con el programa GUITAR RIG directamente a tra-
vés de la conexión USB, también es capaz de enviar mensajes MIDI para controlar otras apli-
caciones externas. Sin embargo, también cuenta con una interfaz MIDI provista de un canal de
entrada y otro de salida.

Para usar un controlador conectado a la entrada MIDI, asegúrese de que el canal MIDI del RIG
KONTROL esté activado en GUITAR RIG:

1. Abra la ficha “Audio and MIDI Settings”. En Windows, se halla bajo el menú de archivos
(File). En Mac OS X, se halla en el menú de GUITAR RIG.

2. Vaya a la ficha MIDI.
3. En Inputs, localice la entrada RIG KONTROL y actívela haciendo clic en la columna Sta-

tus.
El canal de entrada MIDI se configura en el panel de opciones (Options) de GUITAR RIG: en la
ficha Preferences, haga clic en el menú desplegable de MIDI channel y seleccione 1-16 u om-
ni. Para saber la manera de asignar funciones a controladores MIDI externos, consulte la guía
de inicio rápido o el manual de la aplicación.

7.3 Empleo de pedales e interruptores de pie adicionales
 

El RIG KONTROL presenta dos enchufes que sirven para conectar pedales e interruptores de
pie externos mediante cables de un ¼". Una vez conectados y configurados, podrán ser asigna-
dos como controladores MIDI en GUITAR RIG. Consulte la guía de inicio rápido o el manual de
la aplicación para más información.

En el cuadro de preferencias (Preferences) del panel de opciones (Options), GUITAR RIG pre-
senta las siguientes configuraciones:

Empleo del RIG KONTROL como un controlador
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► Para calibrar un pedal externo, haga clic en el botón Reset junto a “Rig Kontrol Ext Pedals
Calibration”.

La opción Rig Kontrol Ext Pedal 1/2 Mode permite configurar cada una de las entradas para
que coincidan con el pedal o interruptor de pie externo. Consulte la especificaciones del fa-
bricante para averiguar si el pedal es "tip" o "ring" o si el interruptor de pie es un control de
apertura o cierre. Si surgieran problemas, pruebe entonces los otros modos disponibles.

Empleo del RIG KONTROL como un controlador
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8 Solución de problemas

 

Si se encontrara con algún problema en el funcionamiento de su unidad, antes de ponerse en
contacto con nuestra asistencia técnica, le recomendamos seguir los pasos siguientes para en-
contrar una posible solución.

▪ Visite el banco de conocimientos de NI. La manera más fácil es yendo a Help > Visit the
Knowledge Base..., desde el menú de GUITAR RIG.

▪ Visite también el foro de usuarios de NI en:
http://www.native-instruments.com/forum/

Al ponerse en contacto con el equipo de asistencia técnica de Native Instruments, asegúrese
de tener a mano toda la información relevante. Para saber la versión del controlador y del firm-
ware, consulte el panel de control del controlador:

▪ En ordenador con Windows, hallará la versión del controlador y del firmware en el panel
de control del RIG KONTROL. Abra la carpeta Rig Kontrol 3, presente en la carpeta de
programas de Native Instruments y haga doble clic en Rig Control 3 Control Panel. Luego,
haga clic en Help > About Rig Kontrol 3 Control Panel para mostrar la información.

▪ En ordenadores con Mac OS X, puede acceder al panel de control del controlador desde el
sistema de preferencias. La información aparecerá en la ventana principal.

Visite por favor esta dirección URL para ponerse en contacto con nuestro equipo de asistencia
técnica:

http://www.native-instruments.com/support/

Todos los productos de NATIVE INSTRUMENTS han sido probados reiteradamente en situacio-
nes reales durante su fase de desarrollo. Sin embargo, si el producto necesitara ser devuelto,
el equipo de soporte técnico le dará un número de RA (Return Authorization) para tramitar el
procedimiento. Contáctese con nuestro equipo de ayuda técnica antes de efectuar cualquier ti-
po de devolución. Los paquetes que sean devueltos sin este número de RA no podrán ser co-
rrectamente identificados y no podrían ser procesados de manera eficiente.

Solución de problemas
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8.1 Problemas relacionados con el audio
 

Este apartado brinda información para los problemas de audio más habituales que pudieran
suceder.

8.1.1 No hay sonido o suena poco volumen
 

Hay varias razones posibles por la cuales no se produce sonido o el mismo sale con poco volu-
men:

▪ Cables rotos o desconectados. Revise todos los cables y conexiones.

▪ Se ha seleccionado una tarjeta de sonido o una entrada de audio incorrecta. Revise por
favor la ficha Audio and MIDI Settings del menú de GUITAR RIG para ver si el controlador
del RIG KONTROL se encuentra seleccionado.

▪ Se ha seleccionado el canal equivocado en el módulo de entrada de GUITAR RIG. Conec-
te el instrumento en otro enchufe o seleccione otro canal en la cabecera de la interfaz de
usuario.

▪ La ganancia de entrada del RIG KONTROL está muy baja. Suba el volumen de entrada.

▪ La perilla de volumen de su instrumento está bajada. Suba la perilla de volumen.

8.1.2 Señal distorsionada
 

Si la señal de audio suena distorsionada y, sin embargo, GUITAR RIG no está añadiendo nin-
gún tipo de distorsión, lo más probable es que la ganancia del RIG KONTROL esté muy alta.
Reduzca el nivel de entrada de la interfaz para evitar que el preamplificador cause distorsión.
Si su instrumento produce una señal tan alta como para que el preamplificador esté siempre
saturado, reduzca entonces su volumen. Normalmente, esto sólo sucede cuando el instrumento
viene equipado con una electrónica especial, como por ejemplo pastillas de alta salida.

8.1.3 Ruido
 

Cuando se percibe zumbido, las razones que lo causan pueden ser variadas:

Solución de problemas
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▪ Las pastillas de bobinado simple son propensas a recoger las interferencias eléctricas. Las
pastillas Humbucker producen mucho menos ruido.

▪ Su guitarra está muy cerca del equipo eléctrico. Para reducir este tipo de zumbido, des-
place la guitarra más lejos del equipo.

▪ La perilla de volumen de la guitarra está puesta muy bajo. Suba la perilla. Si la guitarra
cuenta con más de una perilla de volumen, verifique el volumen de todas la perillas.

▪ Está empleando un cable roto o que no está debidamente protegido. La pantalla de la gui-
tarra podría no ser suficiente. Primero trate de reemplazar el cable por un modelo con
pantalla protectora. Si esto no funciona, un profesional debería revisar la electrónica de
su guitarra y dotarla de una protección mejor.

Si percibe siseos, el volumen de entrada del preamplificador del RIG KONTROL puede estar
demasiado bajo. Suba el volumen del instrumento o incremente el nivel de entrada del RIG
KONTROL. Para más información sobre el ajuste del volumen de entrada, consulte la sección
4.4 (Windows) o la sección 5.4 (Mac OS X) de este manual.

8.1.4 Bucles de masa
 

Los bucles de masa (generalmente percibidos como un zumbido de baja intensidad) son un
problema frecuente que se produce cuando varios dispositivos eléctricos forma parte del mis-
mo circuito eléctrico. Los siguientes pasos lo ayudarán a eliminarlos:

► Desconecte todos los dispositivos que no esté usando, p. ej., dispositivos periféricos conec-
tados al ordenador (discos externos, grabadoras de CD/DVD, etc.).

► Conecte una caja DI detrás de las salidas del RIG KONTROL. La mayoría de estas cajas tie-
nen un interruptor que se usa para romper el bucle y eliminar de esta forma el ruido.

8.2 Problemas relacionados con el hardware
 

Verifique la disponibilidad de actualizaciones y otras informaciones relativas al RIG KONTROL
en el sitio de Internet de Native Instruments y en el Service Center.

Solución de problemas
Problemas relacionados con el audio

 

RIG KONTROL 3 - Guía de usuario - 42



8.2.1 Problemas relativos al controlador
 

Asegúrese de que el RIG KONTROL esté conectado al ordenador y abra el panel de control. La
ubicación del mismo ya la hemos señalado en la introducción de este capítulo

Si el panel de control no se encontrara, es probable que el controlador de dispositivos no se
haya podido instalar. En este caso, vuelva a instalar el controlador de la manera descrita más
arriba en este manual.

Si todos los menús desplegables del panel de control aparecen de color gris, significa que el
RIG KONTROL no ha sido reconocido por el controlador. Es posible que algo no ande bien con
la conexión USB, la sección siguiente le brindará más detalles al respecto.

8.2.2 Problemas relativos a la conexión USB
 

RIG KONTROL es una interfaz USB 2.0 y no funcionará en puertos USB 1.0 o 1.1. Lo mejor
es conectar el aparato directamente en un puerto USB 2.0 del ordenador. Además, el puerto
necesita cumplir los requisitos mínimos de alimentación eléctrica de un puerto USB 2.0 (500
mA). Algunos ordenadores no satisfacen el estándar oficial de alimentación eléctrica para
puertos USB 2.0. En este caso, es posible que un mensaje aparezca indicando que no hay su-
ficiente energía disponible para operar el dispositivo. RIG KONTROL podría entonces producir
crepitaciones o directamente no funcionar.

▪ Si su ordenador no puede suministrar suficiente energía, haga la prueba de conectar su
RIG KONTROL en un hub USB 2.0 con fuente de alimentación propia. En este caso, de-
bería evitar la conexión de otros dispositivos al hub, dado que éstos disminuirían la poten-
cia total disponible.

▪ En caso de fallas, resulta útil comprobar si RIG KONTROL funciona mejor al desconectar
los otros dispositivos USB del ordenador.

▪ Si experimenta fallas en el audio o algún otro tipo de problema relacionado con la cone-
xión USB, conecte el RIG KONTROL en otro puerto USB 2.0 del ordenador.

▪ Un cable USB en mal estado puede ser responsable de las caídas en el audio y de otros
problemas de conectividad. Pruebe con un cable diferente (con el logo oficial USB); en
algunos casos también resulta beneficioso emplear un cable más corto.

Solución de problemas
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▪ Si RIG KONTROL experimenta problemas de mal desempeño en una máquina Windows,
lo primero que debería hacer es deshabilitar el control de alimentación de los hub USB,
que siempre se encuentra activado por defecto. Vaya al administrador de dispositivos (Pa-
nel de control > Sistema > Hardware) y haga clic con el botón secundario en un hub USB
para abrir sus propiedades. En la página de control de alimentación desmarque todas las
casillas. Repita esto para cada hub y luego reinicie el sistema.

8.2.3 Empleo del RIG KONTROL con un ordenador portátil
 

Primero debería verificar que el ordenador sea apto para manejar el procesamiento de audio en
tiempo real sin experimentar fallas. En la red encontrará un par de herramientas gratuitas que
le servirán para analizar la capacidad de su sistema, por ejemplo:

www.thesycon.de/deu/latency_check.shtml

Inicie esta herramienta con el RIG KONTROL desconectado. En caso de que su ordenador no
pueda procesar audio sin experimentar problemas, la herramienta le mostrará barras rojas de
latencia y reportará esto en la caja situada abajo de todo.

En general no se recomienda el empleo de ordenadores portátiles con tarjetas de memoria grá-
fica compartida. Seguramente, va a necesitar toda la memoria y capacidad de procesamiento
disponibles para su proyecto de audio.

Aquí le presentamos algunos consejos para optimizar el desempeño de su portátil:

► No se recomienda usar el ordenador con las baterías porque el administrador de energía po-
dría hacer atrasar el reloj del CPU para ahorrar consumo.

► Desconecte todo los aparatos que no vaya a usar (p. ej., impresoras y escáneres). Esto ali-
viará el trabajo del ordenador y aumentará la capacidad de procesamiento disponible para el
programa musical.

► Los ordenadores portátiles están equipados con dispositivos integrados que pueden pertur-
bar el procesamiento de audio, entre los más comunes se cuentan los adaptadores de red y las
tarjetas inalámbricas LAN. Es posible que tenga que desconectar estos dispositivos cuando
quiera trabajar con el RIG KONTROL.

Solución de problemas
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9 Especificaciones técnicas

 

Esta sección contiene todas las especificaciones técnicas relevantes del dispositivo RIG KON-
TROL.

9.1 Enchufes
 

▪ 2 enchufes de entrada (In 1, In 2) para clavijas mono de 6,3 mm (1/4 pulgada).

▪ 2 enchufes de salida (Out 1, Out 2) para clavijas mono (no balanceado) de 6,3 mm (1/4
de pulgada) o conectores TRS (balanceado).

▪ 1 enchufe estéreo de auriculares para clavijas de 6,3 mm (1/4 pulgada).

▪ 2 entradas para enchufes de pedales externos/ interruptores de pie/cajas interruptoras.

▪ (Pedal 1, Pedal 2) para clavijas estéreo de 6,3 mm (1/4 pulgada).

▪ 2 conectores circulares MIDI (In/Out) de 5 patillas.

▪ 1 USB 2.0 Tipo B.

9.2 Especificaciones de audio
 

Entradas de audio (A/D)  

Canales 2

Frecuencia de muestreo 44,1; 48; 88,2; 96 y 192 kHz

Resolución en bits 16 y 24 bits

Convertidor Cirrus Logic
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Entradas de instrumento  

Impedancia de entrada 1 M Ohm

Nivel máximo con ganancia máxima -5,5 dBu

Nivel máximo de entrada +16 dBu

SNR (ponderado) >100 dB

THD+N 00,009%

Respuesta en frecuencia +/- 0,5 dB, 20 Hz – 24 KHz

Rango dinámico 105 dB (ADC)

 

Entradas de línea  

Impedancia de entrada 44 KOhm

Nivel máximo con ganancia máxima -5,5 dBu

Nivel máximo de entrada +16 dBu

SNR (ponderado) >100 dB

THD+N 00,009%

Respuesta en frecuencia +/- 0,5 dB, 20 Hz – 36 KHz

Rango dinámico 105 dB (ADC)

 

Salidas de audio (D/A)  

Canales 2

Frecuencia de muestreo 44,1; 48; 88,2; 96 y 192 kHz

Resolución en bits 16 y 24 bits

Convertidor Cirrus Logic
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Salidas de línea  

Impedancia de salida 100 Ohm

Nivel máximo de salida +6,3 dBu

SNR (ponderado) >100 dB

THD+N 00,010%

Respuesta en frecuencia +/- 0,5 dB 22 Hz – 44 KHz

Interruptor de nivel alto/bajo Máximo 5 Vpp / -14 dB

 

Salida de auriculares  

Impedancia de carga 8-600 Ohm

Nivel máximo de salida 1,61 V rms @ 100 Ohm

SNR (ponderado) > 91 dB

THD+N (60 Ohms) 00,013%

Respuesta en frecuencia +/- 0 m 5 dB 22 Hz – 44 KHz

9.3 Suministro de energía
 

Interfaz USB 2.0, bus de 5 V - 500 mA. No se necesita ninguna otra fuente de energía o bate-
ría, solamente es requerida la energía del USB. Sin embargo, el funcionamiento adecuado sólo
se garantiza cuando RIG KONTROL está empleado como único dispositivo individual de un
controlador USB 2 o con un hub USB 2 con fuente de alimentación propia.

9.4 Dimensiones y peso
 

▪ Dimensiones: 360 x 237 x 102 mm (14,1 x 9,3 x 4 pulgadas)

▪ Peso: 2,6 kg (5,7 lb)

Especificaciones técnicas
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9.5 Especificaciones ambientales:
 

▪ Temperatura de funcionamiento: de 0°C a 40°C (32°F s 104°F), (85% de humedad no
condensada)

▪ Temperatura de almacenamiento: entre -20°C y 50°C (-4°F a 122°F), (85% de humedad
no condensada)

9.6 Requisitos del Sistema
 

▪ Mac OS X 10.6 (última actualización), procesador Intel Core Duo, 1 GB de RAM y USB
2.0

▪ Windows 7 (último Service Pack, 32/64 bits), procesador Intel Core Duo o AMD Athlon
64, 1 GB de RAM y USB 2.0

Especificaciones técnicas
Especificaciones ambientales:
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